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Installing IMS 
Overview 
Integrated Messaging Service (IMS) is an addition component to Voicemail Pro. It allows users to deal 
with voicemails through their normal email interface (Microsoft Outlook or Exchange). Voicemails can still 
be handled conventionally using just the telephone. 

With IMS, voicemails are presented with a special icon in the user's email inbox. When a voicemail is 
opened, a special form appears which enables the user to play back the message on their telephone. 
The voicemail message itself remains on the voicemail server. 

When a voicemail is read, forwarded or deleted, either from the email or by using the phone, its status is 
reflected in both the mailbox and the email inbox. 

• Playing Messages Through the PC  
Normally IMS plays the voicemail messages through the PC user's telephone. IMS can be set up 
to send the voicemail messages as wav files which are played using the PC's sound capabilities. 
However, this creates a heavy load on the network and servers and so is not recommended. 
Typically, one minute of speech requires the transfer of a 1MB file across the network. 

• Required Network and Exchange Server Knowledge  
Installation of IMS requires access to the customer's Exchange server and to other critical 
components of their network. The installation should be performed only by an installer with good 
knowledge of Exchange Server and Microsoft network setup. The installation should also be 
performed only in conjunction with the customer's network manager. 
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IMS Limitations 
IMS is designed to work in a system that comprises one IP Office and one Microsoft Exchange Server. It 
can be used in a system with more than one telephone system as long as that system has centralized 
voicemail using just one voicemail server. 

IMS cannot be used to: 

• Compose a new voicemail. 

• Reply to a voicemail. 

• Add comments to a forwarded voicemail. 

• Mark a voicemail as urgent. 

• Voicemails should not be placed in Public Folders. 

• Clients that do not use TCP/IP are not supported. 

• When it starts up, IMS only scans the root inbox for new messages. 
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IMS Components 
IMS consists of the following components. 

 
• Voicemail Pro  

Provides voicemail services to the IP Office users. 

• IMS Server  
This consists of two services installed on the Voicemail Pro Server PC: 

• IMS Voice Service  
Handles the delivery of messages when the user selects to play a message from 
Outlook.   

• IMS Gateway Service  
Interacts with the Voicemail Pro Server, the Exchange Server and the IMS Clients. Stores 
the current known status of voicemail messages and mirrors that status in both user's 
email and voicemail mailboxes. 

• Microsoft Exchange Server 
The customer's MS Exchange server. 

• IMS Administration Tool 
This tool is used to maintain the association of voicemail mailboxes to email mailboxes. 

 

The following components are required on the user PCs. 

• Microsoft Exchange or Outlook  
Microsoft Exchange Client or Outlook 97 or higher. Outlook 2003 (Cache Mode off) 

• IMS Client  
Installed on each email user's PC. This provides a voicemail interface within the user's Microsoft 
Exchange or Outlook program. 
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IMS Client PC Requirements 
These are the general requirement for a user PC to run the IMS Client application.  

1. Minimum PC specification for an IMS Client PC  
These are minimum specifications and in most cases will not meet the customer's expectations 
for acceptable performance.  The end user's PC should be a newer PC to meet the customer's 
expectations and will far exceed the minimum specs listed above. 

RAM HD Pentium Celeron AMD XP 
Pro 

2000 
Pro 

2003 

64MB 160Mb 800MHz Celeron 3 
800MHz 

Althon B 
650Mhz 

   

2. The client must use TCP/IP networking. 

3. Users must be members of the same Domain as the IMS/Voicemail Pro Server. 

4. The supported email services are MS Exchange 2000 and 2003. 

5. The IMS client is supported with Microsoft Outlook 2000/2003 with cache mode off. 

6. If you are the installer or system administrator, you must log on to the Client PC as the person 
who is going to be using the IMS software and you must have Administrator rights for that PC to 
install the software. 

7. Outlook must already be installed and configured on the user's PC. Test this by using Outlook to 
send a test message. 
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IMS Server PC Requirements 
In addition to the Voicemail Pro server requirements, IMS requires the following. 

• The voicemail server to use MAPI. 

• Access to a Microsoft Exchange 5.5, 2000 or 2003 (SP1 and SP4) server. 

• An Exchange User account for user IMS. 

• A list equating Exchange User account names with voicemail box users.  

• Use of the Large Fonts setting is not supported. Use of this option may cause options on some 
screens to become inaccessible. 

 

Operating System Support  
Voicemail Pro with IMS is only supported on the following Windows operating systems:  

• Windows 2000 Server with SP2.  

• Windows 2003 Server with SP1.   

 

• Windows 64-bit versions of the above are not supported.  

• Variants of the above such as Windows SBC and Windows DataCenter are supported.  

• No other operating systems are supported.  

 

Network Requirements 
• 100Mbps network card. 

• The server PC should be configured and tested for TCP/IP networking.  

• We strongly recommend that the voicemail server PC is connected to the IP Office Control Unit 
directly. If this is not possible it should be connected via a LAN switch rather than a LAN hub.  

• If directly connected to the IP Office control unit, change the settings of the PC network card to 
match the IP Office control unit as listed in the table below.  

• All IP Office LAN ports are 10Mbps/100Mbps auto sensing but it is recommended that the 
settings of the LAN switch port or network card connected to the IP Office are set as listed in the 
table below.  

IP Office Control Unit Use Port Speed Duplex 

Small Office Edition Any LAN port 100Mbps Full duplex

IP406 V2 Any LAN port 100Mbps Full duplex

IP412 LAN1 100Mbps Half duplex

IP Office 500 LAN 100Mbps Full duplex

• The PC should have a fixed IP address. Although PCs in a DHCP network may retain the same 
IP address between reboots this is not guaranteed. 

• If the IP Office is acting as the DHCP server, it defaults to using 192.168.42.2 to 
192.168.42.201 for DHCP clients. This leaves 192.168.42.202 to 192.168.42.254 for 
devices that require fixed IP addresses. 
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Disk Space Requirements  
A Voicemail Pro installation including VPNM and IMS requires the following free hard disk space.  

• Up to 2GB of disk space for the software and language prompts 

• An additional 1MB of disk space per minute for messages and other recordings. 

• For Avaya IP Office Small Office Edition, you can expect to require at least 200 minutes of 
message recording space which is 200MB. 

• For a busy environment you can expect to require at least 1000 minutes of message 
recording space, that is 1GB. 
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A. IMS Server Installation 
A0. Installation Checks 

 
Before proceeding with installation ensure that the following requirements are meet:  

 

1. Preparation 
1.  Read the Documentation in Full 

Ensure that you have read the documentation for IMS Installation in full and have note all 
the additional requirements for the IMS server, domain interaction and IMS client setup.  

2.  Read the IP Office Technical Bulletins 
Ensure that you have read the IP Office Technical Bulletins relating to the IP Office core 
software and the Voicemail Pro software being installed. These can be obtained from 
http://support.avaya.com and from http://marketingtools.avaya.com/knowledgebase.  

2. Information Required 
1.  IP Office Feature Key Dongle Serial Number  

This is printed on the Feature Key, prefixed with S/N.  

2.  IP Office Licenses 
Ensure that the details of the supplied licenses match the Feature Key serial number. The 
minimum required licenses for Voicemail Pro with IMS are: 

•  Voicemail Pro (4 ports) license. 
•  Integrated Messaging license.    
• Additional Voicemail Pro (ports) licenses may be required depending of the 

number of simultaneous voicemail accesses and users.  

• For IP Office 500 systems an IP500 Upgrade Standard to Professional license 
is also required.  

3.  IP Office System Details 
Service User name and password for access to the IP Office system configuration.  

4.  Network Administration Access  
Contact details of the network and Exchange server administrator.  

5.  User Details 
Listing linking email accounts and IP Office user names. Also detailing the location and 
contact information for the users.  

3. Materials Required 
1.  IP Office Administration Applications CD. 
2.  IP Office Voicemail Pro CD.  
3.  IP Office Application Firewall Batch File 

This file can be obtained from 
http://marketingtools.avaya.com/knowledgebase/tools/firewall.  

4. Only when you have completed the above process should you proceed to A1. Creating the IMS 
Account.  
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A1. Creating the IMS Account 
 

A domain user and mailbox account must already exist for the account named IMS. For information 
about creating this account, see Creating and Configuring the IMS Account. The Voicemail Pro software 
needs to be installed using an account with full administrator rights on the PC. The service subsequently 
runs under that account. We required that a specific account, IMS is created for this purpose and set so 
that its password does not expire. 

The IMS account must be a member of the administrator’s group on the IMS server PC. Note, it is not 
necessary to be a domain administrator, but must be a member of the administrators group on the PC to 
be able to start the IMS and Voicemail Pro services. 

 

To create and configure a domain user and mailbox account called IMS: 
1. Do not proceed with this process until you have completed the steps in A0. Installation Checks.  

2. Working with the network administrator, create an account called IMS on the domain and an 
associated mailbox on the exchange server. Provide a secure password and ensure User 
Cannot Change Password and Password Never Expires are checked. 

3. Make sure that the server PC that will be running IMS and Voicemail Pro is a member of the 
same domain as the Exchange server.  

• Log on using an account with administrative permissions on the domain. 

• Right-click My Computer. Select Properties and select the Network Identification 
Tab.   

4. On the server PC, select Administrative Tools > Computer Management > Groups. 

5. Select Add. From the Look In list select the domain name. 

6. In the Name window, highlight the IMS account and click Add. Click OK twice. 

7. Log out and log back in with the IMS account. 

8. On the desktop, right-click the Outlook icon and select Properties to configure the IMS Account. 

9. On the Mail Properties > General Screen, click Add. 

10. Check the Microsoft Exchange checkbox and click Next. 
11. Type in the Exchange servers name in the Server field, and IMS account in the Mailbox 

field.  Please note, if using Outlook 2003 uncheck Cache Mode. Click Next. 
12. Select No when asked if you travel with this computer. Click Next. 
13. Click Finish. 

14. Highlight the MS Exchange Settings and click Properties. 

15. Highlight Microsoft Exchange Server and click Properties. 

16. Click Check name and ensure the name is resolved. 

17. If the name is resolved, select Apply. Click OK twice and then click Close.  

18. Do not continue until the name has been correctly resolved with the Exchange Server. If the 
name is not correctly resolved, check the Exchange and Mail account details with the Exchange 
Administrator. 

19. Open Outlook and select Yes to register Outlook as the Default eMail application.  

20. Verify that you can send and receive emails.  

21. Only when you have completed the above process should you proceed to A2. IMS Server 
Preparation.  
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A2. IMS Server Preparation 
 

1.  Do not proceed with this process until you have completed the steps in A1. Creating the IMS 
Account.  

2.  Log on to the server PC using the IMS account and check the follow requirements.  

3.  The Server is a Member of the Domain 
The IMS Server MUST be a member of the customer’s domain. 

4.  The Domain Has an User and Email Account IMS 
A domain user and mailbox account must already exist for the account named IMS. The 
Voicemail Pro software must be installed using this account with full administrator rights on the 
PC. The services subsequently run using that account.  

5.  The IMS Account Has Admin Rights on the IMS Server 
The IMS account must be a member of the administrator’s group on the IMS server PC. Note, it 
is not necessary to be a domain administrator, but must be a member of the administrators group 
on the PC to be able to start the IMS and Voicemail Pro services. 

6.  The Server's Outlook Client is Configured for the IMS Account  
Check that the Outlook or Exchange client on the server PC is configured to use the same 
account (IMS).  

7.  Test Email Operation 
Log into the PC with this account (IMS) and verify that you can send and receive emails using 
this account.  

8.  IP Office Manager is Installed 
A PC with IP Office Manager and Microsoft .NET Framework versions 1.1 and 2.0 and Enable 
network COM+ access are installed on the IMS/Voicemail Pro server. IP Office Manager uses 
.NET Framework 2.0 whereas Voicemail Pro uses .NET Framework 1.1. If version 1.1 is not 
detected, you will be prompted to install it before the Voicemail Pro installation proceeds.  

9.  Check or Disable IP Office Voicemail Email Settings 
In the IP Office Manager, the Voicemail Email settings under the voicemail/user tab are switched 
off or are set to a different email account then the one you will be using with IMS. This is 
because the IP Office configuration settings for each user do not apply to IMS. They are usually 
switched off by default but it is advisable to check before you start the installation. For more 
information, see the IP Office Manager help. Please note Voicemail to Email can be used in 
conjunction to IMS for example to send an SMS alert to your SMS enabled cell phone but if set to 
the same Outlook email account as IMS would result in two emails being delivered to the user, 
one that synchronized with their voicemail and one that did not. 
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10.  Disable any Server PC Power Saving Mode  
Switch off any PC and hard disk sleep, power down, suspend and hibernation modes.  

 
11. Disable Network Card Power Saving  

Disable any Network Card  including the power save options for the NIC card under the 
properties of the installed network card.  

 
12. If the server PC is directly connected to the IP Office control unit, adjust the NIC port settings to 

match the IP Office as follows. If connected via a LAN switch, check the LAN switch 
manufacturers documentation for details of the optimum port settings.   

IP Office Control Unit Use Port Speed Duplex 

Small Office Edition Any LAN port 100Mbps Full duplex

IP406 V2 Any LAN port 100Mbps Full duplex

IP412 LAN1 100Mbps Half duplex

IP Office 500 LAN 100Mbps Full duplex

13. Only when you have completed the above process should you proceed to A3. Entering the IMS 
Licenses.  
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A3. Entering the IMS Licenses 

 
The Voicemail Pro must have licenses for itself, any additional voicemail ports required and for IMS. You 
must check that these have been entered into the IP Office systems configuration and that they are valid. 
IP Office 500 systems will also require the IP500 Upgrade Standard to Professional license.  

Without valid licenses the Voicemail Pro will operate for 2 hours before stopping and IMS will not operate 
at all.   

The licenses supplied must match the serial number of the IP Office Feature Key. This is printed on the 
Feature Key and in IP Office 4.0 systems can be checked through the Feature Key Serial Number field 
on the System | System tab in IP Office Manager.  

 

Checking Licenses 
1. Do not proceed with this process until you have completed the steps in A2. IMS Server 

Preparation.  

2. If not already in place, the IP Office Feature Key must be installed.  

1. USB or Parallel Port Feature Key 
These types of keys can be attached to the same PC as the Voicemail Pro server. The IP 
Office Feature Key Server application must be installed on the PC also. Check that the 
application is running and the key recognised before proceeding.  

2. Serial Port Feature Key 
This type of key is connected directly to the DTE port of the IP Office control unit. It does 
not require the Feature Key Server software to be installed on any PC.  

3. IP Office 500 Smart Card Feature Key 
This is the only type of Feature Key supported by IP 500 Office systems. It does not 
require the Feature Key Server software to be installed on any PC. 

3. Start IP Office Manager and receive the current configuration from the IP Office system.  

4. On the System | System tab, check that the License Server IP Address is set correctly. For 
USB and parallel port keys it should be set to the IP address of the PC hosting the key and 
running the IP Office Feature Key Server software. For the serial port keys it should be set to 
0.0.0.0. For IP Office 500 systems the field is not used.   

5. Select  Licence.  

6. If licenses have been entered already, check that their Status is listed as Valid.   

7. Click  and select License.  

8. Enter one of the supplied licenses for Voicemail Pro and IMS.  

9. Click OK. 

10. Repeat until all the licenses are entered.  

11. Click  to send the updated configuration back to the IP Office.  
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12. Reload the configuration again and check that the Status for all licenses is now Valid.  

 
• Note: This screen shot only shows the licenses for Voicemail Pro and IMS. Additional 

licenses may be present for other Voicemail Pro and IP Office features. Do not remove or 
alter any licenses.  

13. If otherwise do not proceed any further until the issue with license validation is resolved.  

14. Only when you have completed the above process should you proceed to A4. Installing the IMS 
and Voicemail Pro Software.  
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A4. Installing the IMS and Voicemail Pro Software 
 

Do not start to install the IMS software before you have completed the necessary pre-installation checks.  

 

To install the IMS and Voicemail Pro Software: 
1. Do not proceed with this process until you have completed the steps in A3. Entering the IMS 

Licenses.  

2. Verify that you are logged in with the IMS account and that the account is a member of the 
Administrator group on PC or is a domain Admin. 

3. Verify that Outlook is installed and setup for the IMS account and that you can send and receive 
emails. 

4. Insert the IP Office Voicemail Pro CD. The installation should auto-start. If it does not auto-start, 
click Browse to locate Setup.exe on the CD and then run it. The Choose Setup Language 
window opens. 

5. Select the installation language. This language is used for the installation and for the default 
language prompts. 

6. Click OK. Installation preparation begins. 

7. If the following window below opens, Voicemail Pro is already installed.  

 
1. Select Modify and click next to see if IMS has already been installed.  

• If IMS and Voicemail Pro have already been installed you will need to upgrade 
rather than install a new version. For more information, see Upgrading a Voicemail 
Pro System.  

• If Voicemail Pro has been installed but not IMS, backup the call flow as described 
in Upgrading a Voicemail Pro System and then uninstall Voicemail Pro and reboot 
the PC and proceed with the installation of Voicemail Pro and IMS.   

8. In the Welcome window, click Next. The Customer Information window opens. 
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9. In the Customer Information window, type a user name and the company name or use the 
default names that are proposed. These settings do not affect Voicemail Pro when it is installed. 

10. In the same window choose the option that determines who should be able to use Voicemail Pro 
when it has been installed. The recommended option is Anyone who uses this computer (all 
users). 

11. In the Customer Information window, click Next.  
12. The Choose Destination Location window opens. Unless there are specific reasons for 

changing the location, the default setting is recommended. Click Next.  
13. The Messaging Components window opens. Select  Voicemail Pro (Full) and click Next.  
14. The Setup Type window opens. In the Setup Type window, select Custom. 

15. Click Next.  
16. The Select Features window opens so that you can select which additional Voicemail Pro 

features to install. For IMS ensure that the settings are as follows: 

• Voicemail Pro Campaign Web Component is not required for IMS but is installed as part 
of a typical Voicemail Pro Server installation. If a web server has already been installed 
but the Voicemail Pro Campaign Web Component is not required, uncheck it to remove it. 
If Voicemail Pro Campaign Web Component is required for other use, make sure that it is 
checked so that it is not removed. 

• Ensure that Voicemail Pro Client and Voicemail Pro Service are checked. 

• Check any additional languages that are required. It is recommended that either English 
or English US is always selected (installed by default) in addition to any languages that 
are required by the customer. 

• Important 
Do not uncheck any other boxes as this will remove the corresponding software 
features. 

• Scroll down and check Integrated Messaging Service. That should automatically select 
all the components for IMS.  

 
18. Click Next.  
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19. If you have chosen to install the Voicemail Pro Campaign Web Component, the Select the Web 
Server root directory window opens.  

1. Type the path to the folder where you would like to save the web campaign web pages. 
Alternatively, use the default location or click Browse and select a folder to use. Click 
Next.  

2. The Select the Destination of the Script directory of Your Web window opens. Type 
the path to the folder where the web campaign components are to be installed. 
Alternatively, use the default location or click Browse and select a folder to use. Click 
Next.  

20. The Service Account Name window opens. Details of the default administrator account are 
already filled in. 

21. In the Service Account Name window, type the User Name and Password for the IMS account 
created previously on the domain and Exchange server.  

 
• Alternatively, click Browse and select from the list of available network accounts. The 

IMS account should show up in the list. Verify that you can browse for this account. Make 
sure the IT manager has not hidden this account for Exchange or has separated this 
account in Active Directory.  

22. Click Next.  
23. The Select Program Folder window opens. It is recommended that you use the default folder, IP 

Office, which will already be shown.  Click Next.  
24. The Start Copying Files window opens. You are presented with a summary of the settings that 

you have chosen so far. Review the settings to make sure that they are what you expect. In 
particular, check that the required languages are listed. Scroll down if necessary. The minimum 
requirements for IMS are listed below. If for any reason the details are not what you expect, click 
Back and make the necessary changes. 

• Voicemail Pro 
- Voicemail Pro Client. 
- Voicemail Pro Service. 

• Integrated Messaging Service. 
- IMS Client Package. 
- IMS Database Service. 
- IMS Gateway Service. 
- IMS Voice Service. 
- IMS Administration Tool. 

25. When you are satisfied that the details are correct, click Next to start copying the files. The Setup 
Status window opens to keep you informed while the installation takes place. 
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26. When the installation is complete, click Finish to restart now. 

27. An attempt is made to start all services associated with Voicemail Pro and IMS. 

 
28. After the services have started, the installation process continues.  

29. The IP Office Voicemail Pro - System Settings window opens.  

 
30. Select the required logging levels. Logging may be useful for fault diagnostics. You can switch 

logging off after you have verified that IMS is working correctly. Click Next.  
31. The IP Office Voicemail Pro - Path Settings window opens. 

 
32. Enter the name of the server PC on which Voicemail Pro and IMS have been installed. In most 

cases the name is detected automatically and filled in for you. If not, click Browse and provide 
the name of the Integrated Message Voice Server. If this fails it is most likely because the IMS 
Gateway Service is not running.  
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33. Click Next. The IP Office Voicemail Pro - Email Settings window opens.  

 
34. In the Account Details field, type the name of the account IMS. Alternatively, click Browse and 

find the IMS account. 

• If wav files of voicemail messages are to be sent in emails rather than left just in the 
voicemail mailbox check Transmit Wave Files. Sending .wav files across a network 
creates a high loading on the network and network servers. A one minute message 
requires a 1MB .wav file. Choose either: 

• Attach wave file to message to allow a recipient to copy a .wav file for use 
elsewhere. 

• Embed wave file in message to allow a recipient to embed a file in a message. 
An embedded file is compressed and therefore smaller than an attached file. 

35. Click Next. The IP Office Voicemail Pro - SMTP Email Settings window opens.  Note that IMS 
uses MAPI so this setting does not pertain to IMS but Voicemail to Email.  

36. Click Finish. An attempt is made to validate the SMTP email settings. If the attempt to connect 
with the SMTP server fails, an error message is displayed. This can be ignored if SMTP is not 
being used (which it is not for IMS services).  
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A5. Check the IMS Services 
 

If Voicemail Pro has been installed successfully, the voicemail service is started automatically. However 
it is useful to check them and to know how to stop-start the services manually.  

To check/restart the Voicemail Pro and IMS Services 
1. Do not proceed with this process until you have completed the steps in A4. Installing the IMS 

and Voicemail Pro Software. 

2. Open the Windows Control Panel. 
3. Select Administrative Tools > Services.  

 
4. The Voicemail Pro service and IMS services should be visible. Their Status should be Started 

and the Startup Type should be set to Automatic.  

5. The details should also show that the services are running under the IMS account.  

6. If it necessary to manually restart the services, ensure that the following order is used: 
VMProDBService (if installed), Voicemail Pro Service, IMS(Restart), IMS(Voice) and finally 
IMS(Gateway).  

7. Close Services.  

8. Only when you have completed the above process should you proceed to A6. Initializing the 
Call Flow.  

Using a Batch File to Start Services  
In some instances, certain computers might not respond quickly enough in order to start all of the Avaya 
services in the correct order. In this circumstance, it can be advisable to create a batch file which will 
delay the start of these services until the PC is fully running. 

Avaya IP Office Services can be started successfully at system start-up using a scheduled task that 
initiates the batch file below. This batch file ensures that the services will start successfully and in the 
proper order. 

1.  Set all Avaya services listed below to Manual start. Do not include Key Server. 

2. Create the batch file below and save it to %SYSTEMROOT%. Only include lines for the services 
which are installed.  

@echo off 
rem Wait 60 seconds before execute. 
timeout /t 60 
net start VMProDBService 
net start Voicemail Pro Service 
net start IMS(Restart) 
net start IMS(Voice) 
net start IMS(Gateway) 

3. Create a scheduled task to start the batch file at system start-up.  
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A6. Initializing the Call Flow 
 

This stage will check both that the Voicemail Pro Client can connect to the Voicemail Pro Server, and 
also initialize the call flows.  

 

To Initialize the Voicemail Pro Call Flow:  
1. Do not proceed with this process until you have completed the steps in A5. Check the IMS 

Services.    

2. Select Start | Programs | IP Office | Voicemail Pro Client.  
3. The Voicemail Pro Client should start and display Connecting to the Local Server. 

4. Once it has connected the various navigation panes should show content.   

2. Click the  Save and Make Live icon. 

3. Select Yes.  

4. Voicemail operation can now be tested from an extension by dialing *17.  

5. Only when you have completed the above process should you proceed to A7. Associating 
Voice Mailboxes with Email Addresses.  
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A7. Associating Voice Mailboxes with Email Addresses 
 

When you have installed IMS, started the Voicemail Pro server, you are ready to associate the user 
voicemail mailboxes with email mailboxes on the Exchange Server. This is done using the IMS 
Administration tool. 

 

To associate a voice mailbox with an email address 
1. Do not proceed with this process until you have completed the steps in A6. Initializing the Call 

Flow.  

2. From the Start menu, select Programs | IP Office | IMS Administration Tool. 
3. From the Server menu, if the server is not already populated, select Add. The New Integrated 

Messaging Server window opens. 

4. In the Server field, type the name of the IMS Server or click Browse and select a server. When 
the server has been added, the name is displayed with a [+] plus icon. 

5. Expand the [+] icon to show configurable options. 

6. Highlight Integrated Messaging Associations. After a few moments the voice mailboxes are 
displayed in the right-hand window. 

7. Select a voice mailbox to configure and double-click it to see its properties. 

8. In the Associated Email Address field, select Change and select the relevant email address of 
the associated user. 

9. If the mail settings need to be different from the default settings, select the User Properties tab 
and configure as applicable and select OK. 

10. In the Primary NT Account field click Select Existing and select the relevant domain user 
account of the associated user. Note, if the user is opening multiple inbox accounts all have to be 
added. 

1. IP Office Integrated Messaging Pro (IMS) clients may appear to respond slowly or even 
lock up where the IMS client user has defined one or more delegates in Microsoft 
Outlook. All delegates of an IMS Client’s Outlook should have their domain account and 
email address added into the permissions field, with Access permission selected. 

 
11. When complete, click the Synchronize Mailboxes icon to synchronize the mailboxes. 

Alternatively, click Selecting Mailboxes and Synchronize on the menu bar. 

12. Close the IMS Administration Tool. 
13. Make a call to one of the users that you have just associated and leave a message in their 

voicemail mailbox. A short while after hanging up a message should arrive in the user’s mailbox. 

14. Only when you have completed the above process should you proceed to B1. IMS Client 
Requirements.   
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B. IMS Client Installation 
B1. IMS Client Requirements 

 
During installation of the IMS Server, the IMS Client Installer package is copied to C:\Program 
Files\Avaya\IP Office\Voicemail Pro\IMS\Client and is automatically shared as IMSClient. The 
installer, called IMSClient.exe is approximately 10.1MB is size. You need to install the IMS Client on the 
PC of each user who want to use IMS. 

 

•  CRITICAL WARNING 
Do not install the IMS Client on the same PC as the Voicemail Pro / IMS Server. 

 

1. Do not proceed with this process until you have completed the steps in A7. Associating Voice 
Mailboxes with Email Addresses.  

2. Minimum PC specification for an IMS Client PC  
These are minimum specifications and in most cases will not meet the customer's expectations 
for acceptable performance.  The end user's PC should be a newer PC to meet the customer's 
expectations and will far exceed the minimum specs listed above. 

RAM HD Pentium Celeron AMD XP 
Pro 

2000 
Pro 

2003  

64MB 160Mb 800MHz Celeron 3 
800MHz 

Althon B 
650Mhz 

   

• If the client PC is a Windows server, it must:   

• Meet minimum hardware and operating system requirements for an IMS server, 
see IMS Server PC Requirements. 

• Not be a Domain Controller. 

• Not be the Voicemail Pro / IMS Server. 

3. Clients must use TCP/IP networking. 

4. Users must be members of the same Domain as the IMS/Voicemail Pro Server. 

5. The supported email services are MS Exchange 2000 and 2003. 

6. The IMS client is supported with Microsoft Outlook 2000/2003 with cache mode off. 

7. If you are the installer or system administrator, you must log on to the Client PC as the person 
who is going to be using the IMS software and you must have Administrator rights for that PC to 
install the software. 

8. Outlook must already be installed and configured on the user's PC. Test this by using Outlook to 
send a test message. 

9. The Integrated Messaging Server must already be installed and running.  

10. Only when you have completed the above process should you proceed to B2. Adjusting DCOM 
Settings.  
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B2. Adjusting DCOM Settings 
 

Microsoft have significantly increased the security around many operations included application access 
to functions such as email. The following DCOM changes are therefore essential for support of IMS and 
must be performed before installing the IMS Client.  

The DCOM changes can be done either through a security policy that is then applied to all PCs in the 
domain, otherwise the individual settings on each client PC must be adjusted.  

 

To set the Client PC's DCOM Settings  
1. Do not proceed with this process until you have completed the steps in B1. IMS Client 

Requirements.    

2. Using one of the methods described below, ensure that the DCOM settings of the client PC are 
adjusted to support interaction with the IMS server.  

• B2a. Setting the Changes on a DCOM Security Policy. 
• B2b. DCOM Settings for a Windows 2000 PC.  
• B2c. DCOM Settings for XP Pro and Windows 2003 PC's.  

3. Only when you have completed the above process should you proceed to B3. Installing the IMS 
Client Software.  
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B2a. Setting the Changes in a DCOM Security Policy  
Setting all DCOM security settings for a domain to work with IMS. After setting the DCOM options, this is 
now a domain wide policy and when the IMS clients are installed and the computer is rebooted and the 
user logs on, these settings will be pushed to the end user. Doing this as a policy simplifies the 
installation process for IMS.  

1. On the domain controller, open Active Directory Users and Computers, right click on the 
domain to be administered and select Properties.  

 
2. Select the Group Policy tab.  
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3. Double click Default Domain Policy. Drill down to Computer | Windows Settings | Security 
Settings | Local Policies | Security Options.  

 
4. Search for the DCOM Machine Access Restrictions ... entry and double click on that entry.  

 
5. Check Define this policy setting and then click Edit Security.   

 
6. Add the Everyone and Anonymous Logon users and set them to Allow for remote and local 

access. Click OK. 

7. Click OK.  

8. Repeat this process for all DCOM entries.  
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B2b. DCOM Settings for a Windows 2000 PC 
This process adjusts the DCOM settings on an individual PC running Windows 2000.   

1. Select Start | Run.  

 
2. Enter DCOMCNFG and click OK.  

 
3. On the Default Properties tab, set the following: 

• Enable Distributed Com on this computer. 
• Default Authentication Level set to “NONE” 

• Default Impersonation Level set to “Impersonate”. 

4. Click on the Default Security tab.   
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5. Click on the Edit Default button for Default Access Permissions. 

 
6. The Everyone Group should have Allow Access set.  Click OK. 

7. Click on the Edit Default button for Default Launch Permissions. 

 
8. The Everyone Group should have Allow Launch set. Click OK. 

9. Click on Edit Default button for Default Configuration Permissions.  

 
10. The Everyone Group should have Full Control set. Click OK. 

11. Click Apply.   

12. Click OK. 

13. Reboot the PC.  
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B2c. DCOM Settings for XP Pro SP2 and Windows 2003 SP1 PCs 
This process adjusts the DCOM settings on an individual PC running either Windows XP Pro SP2 or 
Windows 2003 SP1.    

1. Select Start | Run.  

2. Enter DCOMCNFG and click OK.  

 
• Windows XP may attempt to block the Microsoft Management Console. Select Unblock 

to continue.  

3. Click on Component Services. and then Computers. 

 
4. Right click on My Computer and choose Properties. 

5. Select the COM Security tab. Note: Windows XP , Windows XP Service Pack 1 and Windows 
Server 2003 without SP1 will only have Edit Defaults. 

 
6. Edit the limits for Access Permissions and Launch and Activation Permissions to allow 

Remote Access and Remote Launch/Activation permissions for Anonymous Logon and 
Everyone. Note: Windows XP, Windows XP SP1, and Windows 2000 Server grant the Everyone 
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all Permissions. 

 
7. On the Default Properties tab set the following:  

 
• Enable Distributed Com on this computer. 

• Default Authentication Level set to NONE. 

• Default Impersonation Level set to Impersonate. 

8. Reboot the PC.  
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B3. Installing the IMS Client Software 
 

 

To install the IMS Client software:  
1. Do not proceed with this process until you have completed the steps in B2. Adjusting DCOM 

Settings.  

2. Copy the IMS Client installer package to a CD or map a network drive to the folder as follows 
\\VMProIMSPC\IMSClient. This is done automatically when you install IMS on the Voicemail 
Pro/IMS server. 

3. Log on to the user's PC using the user's account.  

4. Verify that the user has local administrative rights to be able to install the software. Once installed 
they should not need administrator rights to use the application. 

5. Save and close all other applications prior to installing as a reboot will be required. 

6. Depending on where it is located, double-click the IMSClient.exe file. 

7. Choose the preferred Language and select OK. 

8. Click Next until you see the IMS Connection Information window. 

9. Enter the following information: 

• Voicemail Mailbox  
This is the entry as it appears in the Username field of the IP Office User Profile Screen. 
This is case-sensitive. If this information is not entered correctly, the IMS client will not 
connect to the IMS Server. 

• IMS Server  
This is the name of the IMS/Voicemail Pro Server.  

10. Click Next. The IMS Playback Parameters window opens. 

11. Type the extension number of the handset to be used for playing back messages. 

12. If required, check Pick Up Automatically for the option to collect messages without the need to 
pick up the handset. This is supported on analog extensions.  

13. When prompted to Restart the PC, click Finish to restart the PC. 

• If you attempt to open Outlook without restarting the computer, you will receive an error to 
tell you a component has not been installed correctly. It is therefore recommended that 
you restart the computer when prompted. 

14. Typically when starting Outlook if there is a connection error, a message should be received 
while Outlook is starting, asking for a user name and password. 

1. On the Outlook Menu Bar, Select Tools – Integrated Messaging. If the IMS Client has 
connected you should only have the option to Disconnect. If this is the case you have 
successfully installed the IMS Client on the workstation. 

2. A further indication will be a Telephone Icon in the mail message. If the Client has not 
been installed, this icon will not be displayed. 

15. Only when you have completed the above process should you proceed to B4. Opening the 
Firewall.  
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B4. Opening the Firewall 
 

It is necessary to create firewall exceptions for the IMS client application after its installation. Even if the 
user does not have a firewall or uses a firewall other than the default Windows firewall, it is 
recommended that the process for the Windows firewall is applied.  

If the firewall being used is the default Windows Firewall, the necessary exceptions can be setup by 
running the batch file AvayaFW.bat. This file is available from the 
http://marketingtools.avaya.com/knowledgebase/tools/firewall. It is recommended that this file is running 
even if the user is not using the firewall.  

 

1. Do not proceed with this process until you have completed the steps in B3. Installing the IMS 
Client Software. 

2. Unzip AvayaFW.bat from the AvayaFW.zip file.  

3. If the path to which applications are being installed is not the default, modify the 
%ProgramFiles% setting within the file.  

4. Run the batch file on the user's PC.  

 

Settings for Other Firewalls  
If the user's PC uses a firewall other than the default Windows firewall, the method of setting up the 
necessary exceptions will vary. For the IMS Client the necessary exceptions are:  

• C:\ProgramFiles\Avaya\IMS Client\UMSForm.exe 

• UDP Port 67 

• UDP Port 69 

• TCP Port 135 

• TCP Port 2000 

• UDP Port 50791 

• UDP Port 50799 
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B5. Testing IMS Client Installation 
 

Typically, when starting Outlook if there is a IMS connection error, a message may be received while 
Outlook is starting, asking for a user name and password. Please recheck the DCOM settings and verify 
that the Windows Firewall exceptions have been setup properly. Next verify that the IMS client has been 
installed properly.  

 

1. Do not proceed with this process until you have completed the steps in B4. Opening the 
Firewall.  

2. In Outlook, select Tools > Integrated Messaging. 

3. If the IMS Client has connected you should only have the option to Disconnect. If this is the case 
you have successfully installed the IMS Client on the workstation. If you can not connect:  

1. Verify that the mailbox is set properly to the user’s Name in Manager.  

2. Check that the proper Voicemail Pro machine name was given when installing the client 
software.  

3. Check the DCOM settings or the Windows Firewall settings not being modified.  

4. If the Integrated Messaging tab does not show up in Outlook Tools > Integrated Messaging or 
under Tools>Options>Integrated Messaging, verify that the IMS Client has not been disabled 
in Outlook.  

1. In Outlook click Help>About Microsoft Office Outlook. 

 
2. Click Disabled Items. If the IMS Client is listed, select it and click Enable. 

 
3. You will have to close and reopen Outlook for it to appear. 
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4. You should see a Telephone Icon in the mail message when you have a voicemail 
message.  

 
5. If the Client has not been installed, or has not been installed correctly, the telephone icon 

will not be displayed. Try uninstalling rebooting and reinstalling. Alternatively you may 
have to manually install the form as detailed below.  

6. Only when you have completed the above process should you proceed to B6. Observing 
Exchange Operation.  
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To Manually Install the Form 
1. In Outlook select Tools | Options.  

2.  Select the Other tab.  

3. Click Advanced Options.  

4. Click Custom Forms and then Manage Forms.  

5. Click Install and browse to and select C:\Program Files\Avaya\IMS Client\UMSForm.CFG.  

 
6. The form properties are shown. Select OK.  

7. The IMS form should now be listed.  

 
8. Click Close and then OK, OK, OK.  

9. Close and restart Outlook.  
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B6. Observing IMS Exchange Mailbox Operation 
 

It is useful to check that the IMS Account has logged onto the Exchange Server correctly. 

 

To check and observe IMS operation: 
1. Do not proceed with this process until you have completed the steps in B5. Testing IMS Client 

Installation.  

2. On the Exchange server, open the Exchange Administration Manager. 
3. Expand the Server Name and Mailbox Store. 

4. Select Logons and locate the IMS account name. Only logged on accounts are displayed. 

5. Select Mailboxes to view IMS messages being received and sent. 

6. Leave a voicemail message in an IMS user’s voice mailbox. 

7. After hanging up you should notice that for a brief time the Total Items field for the IMS mailbox 
increases by 1. The message is then sent from the IMS mailbox to the user’s mailbox, whose 
Total Items increases by 1. By default, there should be no messages left in the IMS mailbox. 
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C. Maintenance 
Upgrading a Voicemail Pro Server with IMS 
 

Upgrade from Voicemail Pro below version 3.2 
It is important that the settings of an existing Voicemail Pro are exported before any upgrade. Although 
folders that contain prompts and messages are not affected by the upgrade process, the editable version 
of a customer call flow is lost. 

Make sure you are logged in as the IMS account. 

 

To upgrade from below Voicemail Pro version 3.2 to version 4.0: 
1. Export the Database  

Before removing Voicemail Pro as part of an upgrade, you must create a backup copy of the call 
flow database. This will contain any customizations made to the default call flow. 

1. Start the Voicemail Pro Client. 

2. From the File menu, select the option Import or Export. 
3. Select the option Export call flows and click Next. 
4. Enter a file path and file name ending in .mdb, for example C:\temp\backup.mdb. Click 

Next. 
5. Click Finish to start the export then click Close to complete the export procedure. 

6. Close the Voicemail Pro Client. 

7. The next step is to back up the registry so that you do not lose any Voicemail Pro settings 
from the previous version. 

2. Back up the Registry  
Any registry settings that are associated with Voicemail Pro need to be backed up. 

1. Insert the Voicemail Pro CD for the new Voicemail Pro and cancel the install wizard that 
auto runs. 

2. Right-click the CD drive and select Open. 

3. Locate the file backupreg.bat and double-click it to run the application. The registry 
settings are backed up. 

4. The next step is to remove Voicemail Pro. Verify that the 3 files were created successfully 
and they have the appropriate data. 

3. Remove Voicemail Pro  
Any previous versions of Voicemail Pro must be removed before you start to install the new 
version. 

1. Open the Windows Control Panel. 

2. Select Add/Remove Programs. 

3. Select IP Office Voicemail Pro and click Add/Remove. 

4. From the options offered, select Remove and click Next. 
5. Follow the prompts that you see on the screen during the removal process. 

6. When the process has been completed, select the option Yes, I want to restart my 
computer now and click Finish.  

7. Please note is it necessary to reboot the server. Do not skip this step. 

4. After the server reboots and you have logged back in as IMS. 
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5. Restore the Registry  
The Voicemail Pro registry that was backed up in step 2 needs to be restored. 

1. Right-click the CD drive that contains the Voicemail Pro CD and select Open (reinsert the 
CD if necessary and cancel the install wizard). 

2. Locate the file restorereg.bat and double-click it to run the application. This restores the 
registry settings previously associated with Voicemail Pro. 

3. Verify that the registry entries have been restored successfully.  

4. Start the Voicemail Pro GUI. 

5. From the File menu, select the option Import or Export. 
6. Select the option Import Call Flows and click Next. 
7. Use the Browse button to locate the backup file then click Next. 
8. Click Finish to start the import then click Close to complete the import procedure. 

6. Install the New Software  
The next step is to install the upgrade software. For more information see Installing Voicemail 
Pro: Overview above and then refer to the sections that relate to the type of Voicemail Pro that 
you intend to install. 

7. Restore the Database  
The copy of the call flow database that contained any customizations made to the default call 
flow needs to be restored. 

1. Start Voicemail Pro. 

2. From the File menu, select Import or Export.  
3. Select Import Call Flows. 

4. Click Next. 
5. Click the Browse button and locate the file that contains the backed up call flows. 

6. Select the file and click Open. 

7. In the Import or Export Call Flows window, click Next. 
8. Click Finish to start importing the database. 

9. Click Close to complete the import process. 

10. Click Save and Make Live. 

8. The new version of Voicemail Pro has been installed. Test that the system is running by dialing 
*17 from any extension. You should hear the mailbox announcement. 
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Upgrade from Version 3.2 
You can upgrade from IP Office Voicemail Pro 3.2 to IP Office 4.0. If you upgrade you can still use a 3.2 
Voicemail Client to update Voicemail Pro 4.0. However, if you want to change any of the new features, 
for example the Outcalling preferences or to use the start points for Personal Announcements, you will 
need to use the latest Client version of IP Office Voicemail Pro. 

 

To upgrade from version 3.2: 
1. Stop the all Voicemail Pro services running. It would be a good idea to make a backup of the 

registry and the Call flows and if possible the Voicemail Pro folder before proceeding.  

2. Insert the new IP Office Voicemail Pro CD. The installation should auto-start. If it does not auto-
start, click Browse to locate Setup.exe on the CD and then run it. The Choose Setup Language 
window opens. 

3. Select the installation language. The language selected is used for the installation. 

4. Click OK. You are asked 'This setup will perform an upgrade of IP Office Voicemail Pro'. Do 
you want to continue? 

5. Click Yes. The Upgrading the IP Office Voicemail Pro window opens. 

6. Click Next to start the upgrade. The setup status window opens. The progress of the upgrade is 
indicated by a time bar. When the InstallShield Wizard complete window opens. 

7. Click Finish. The Email settings window opens. 

8. Enter your email account details and click Next. The IP Office Voicemail Pro Control Panel applet 
settings window opens.  

9. Enter your settings for each form and click OK.   

10. Click Yes when asked if you want to start the Voicemail Pro service. 

11. Reboot the PC and verify that the services start properly and that the voicemail is fully functional. 

12. The new version of Voicemail Pro has been installed. Test that the system is running by dialing 
*17 from any extension. You should hear the mailbox announcement 
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Specifying the Level of IMS Service Logging 
If IMS is installed the Systems Settings tab is available. You can specify the level of service logging for 
the IMS Gateway Server service and the IMS Voice Server service. Four levels of logging are available, 
with increasing level of detail. 

Typically logging is required only if IMS problems are being experienced and diagnosis is required. The 
information is logged in the Event Viewer application. 

 

To specify the level of IMS service logging: 
1. Open the Windows Control Panel. 

2. Select IP Office Voicemail Pro. The IP Office Voicemail Pro window opens. 

3. Click the System Settings tab. 

 
4. In the Logging Level boxes, select the level to use for each of the IMS services. 

• None - No logging recorded. 
• Some - A low level of logging recorded where only errors are logged. 
• Most - A medium level of logging where errors and warnings are recorded. 
• All - All errors, warnings and information are logged. 

5. Click Check to validate the changes that you have made. 

6. Click OK. You are prompted to restart the affected services so that your changes are enabled. 

7. Choose Yes. The services that are affected by your changes are automatically stopped and 
restarted. 
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Specifying the Name of the Host Server PC for IMS 
If IMS is installed the Path Settings tab is available. You need to specify the computer name of the 
server PC that is hosting the IMS Voice Service. Typically, this is installed on the same server PC as the 
Voicemail Pro Server. 

 

To specify the name of the host server PC for IMS: 
1. Open the Windows Control Panel. 

2. Select IP Office Voicemail Pro. The IP Office Voicemail Pro window opens. 

3. Click the Path Settings tab. 

 
4. Type the name of the computer on which the IMS Voice Service has been installed. 

• Alternatively, click Browse and select the name of the computer. 

5. Click Check to validate the changes that you have made. 

6. Click OK. You are prompted to restart the affected services so that your changes are enabled. 

7. Choose Yes. The services that are affected by your changes are automatically stopped and 
restarted. 
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Configuring the IMS Email Settings 
You can configure certain email settings such as the account to use for email and the way in which .wav 
files are transmitted. 

 

To configure email settings 
1. Open the Windows Control Panel. 

2. Select IP Office Voicemail Pro. The IP Office Voicemail Pro window opens. 

3. Click the Email Settings tab. 

 
4. In the Account Details box, type the name of the MAPI email account (IMS) to use for email 

messages. Alternatively, select Browse to display a list of available email accounts. 

• For IMS you should be using the IMS account setup previously. If Outlook is installed 
properly you should be able to browse for this account. If you are able to browse but are 
not able to see the IMS account, verify that the IT manager has not hidden the account in 
Exchange. 

5. Click Check to validate the changes that you have made. 

6. The Message Parameters options are only available if you have installed IMS. For IMS you can 
specify the way in which the .wav files of voicemail messages are to be sent in emails. Sending 
.wav files across a network creates a high loading on the network and networks servers. A one-
minute message requires a 1MB .wav file.  

1. To transmit .wav files, check the Transmit Wave File box. 

2. Choose the option for transmitting the .wav files. Choose either: 

• Attach wave file to message to allow a recipient to copy a .wav file for use 
elsewhere. 

• Embed wave file in message to allow a recipient to embed a file in a message. 
An embedded file is compressed and therefore smaller than an attached file. 

7. Click OK. 
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Troubleshooting DCOM Issues 
Checking both the following options allows DCOM errors to be seen.  

• Enable Auditing  
When you first set up a Windows server or Workstation, the default setting for system wide audits 
is "disabled". Turn on failure audits by using the user manager program, again accessing the 
Policies menu. This time, click on the "Audits" selection. Enable audits and select all of the 
"failure" check boxes and click OK. At this point, any DCOM security problems will start to show 
up in the system event log on the system where they occurred. 

• Check Batch Job Permissions 
The second cause is that the package is configured to run as specific identity, but that identity 
doesn't have "log in a batch job" permissions. This is far more common and easily distinguished 
by testing the component with package identity set to 'interactive user'. If the application will start 
up as the interactive user, but not as the specific identity, then either the identity being used is no 
longer valid (which generates a security failure log message in the system security log) or the 
"log in as batch" permission hasn't been granted to that ID (which generates the weird MTS 
message). 

1. In Windows 2000, enable these options as follows: 

2. On the Start menu, select Programs | Administrative Tools | Local Security Policy.   

3. On the left-hand pane, you see a tree view. Click the plus (+) sign at the left of the Local 
Policies, and you see the Audit Policy entry.  

4. Select the Audit Policy entry, and note that the right pane contains all audit options, which 
one is enabled and which one is not. Right-clicking at any of these options allows you to 
enable or disable them.  

5. Enable auditing for success and failure for the following options: Audit logon events, Audit 
object access, Audit privilege use.  

6. Close the Local Security Policy window.  

 

Once you have activated these logging options, test your client again. After you get the error message, 
use Event Viewer to see if there are any DCOM events. The event may tell you why access was denied. 
Also, it can tell you who is logged on to the client computer and if this is a domain user or a local user. It 
can tell you that the protocol requested by the client is not available on the server, and so forth. COM 
logs are usually added to the system log. 
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Tracing in Debug 
Many applications, including Voicemail Pro and IMS, output activity messages that are viewable in 
Debug View (DbgView). This application can be downloaded from 
http://marketingtools.avaya.com/tools/debug.  

 
 

Installation 
1. Download the zip file.  

2. Unpack the files into a folder such as c:\debug on the server PC.   

3. Run DbgView.exe.  

4. Events are shown in the DbgView window. These can be logged to a file if required. The level of 
detail shown can be filtered to show more or less activity.  

 

Logging 
1. Run DbgView.exe.  

2. Select File | Log Preferences.  

 
3. Set the logging details are required and click OK.  

4. While DbgView is running the viewable trace is also copied to the specified file.  

5. The debug log files can be opened in programs such as Wordpad.   
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Filtering 
1. Select View | Debug Filters.  

 
2. Select the module for which you want to increase/decrease reporting.  

3. In the right hand panel adjust the level of reporting.  

4. Close the Configure Debug Filters window.  
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IMS Tracing 
IMS tracing is enabled through a number of registry keys. The IMS server keys are set through 
HKEY_LOCAL_MACHINE registry values. The IMS client keys are set through 
HKEY_CURRENT_USER. All the keys are all REG_DWORD values and are disabled if not set or set to 
0. 

IMS HKEY_LOCAL_MACHINE\SOFTWARE\AVAYA\Integrated Messaging 
EnableTracing This key must be enabled to allow tracing using the other keys below. 
 

Voicemail HKEY_LOCAL_MACHINE\SOFTWARE\AVAYA\Integrated 
Messaging\Voicemail 

EnableTracing This key must be enabled to allow tracing using the other keys below.  
ConstructorTracing This provides some tracing for when certain COM objects are constructed. 

As a whole it is not required for diagnostics. 
DestructorTracing This provides some tracing for when certain COM objects are destructed. 

As a whole it is not required for diagnostics. 
EnableConnectionTracing Provides diagnostic for when a connection occurs (server to server or client 

to server). 
EnableRefTracing This indicates when the reference count for certain COM objects is 

changed (through AddRef, Release). 
 

Gateway HKEY_LOCAL_MACHINE\SOFTWARE\AVAYA\Integrated 
Messaging\Gateway 

Debugging This key must be enabled to allow tracing using the other keys below.  
ChannelEvtSinkTracing Provide tracing about speech channel events received. 
ConstructorTracing This provides some tracing for when certain COM objects are constructed. 

As a whole it is not required for diagnostics. 
DestructorTracing This provides some tracing for when certain COM objects are destructed. 

As a whole it is not required for diagnostics. 
EnableConnectionTracing Provides diagnostic for when a connection occurs (server to server or client 

to server). 
EnableFunctionTracing Generally used by the client software to trace out information about the 

functions that are being executed. 
EnableObjectTracing Allows certain created COM objects to be traced. 
EnableProxyTracing When a client connects to a server, it connects through a proxy. This 

settings allows information from the proxy to be traced. 
EnableRefTracing This indicates when the reference count for certain COM objects is 

changed (through AddRef, Release). 
EnableTagTracing When certain internal objects are created, such as a channel object for 

speech playback, this information is tracked. Using this setting every 
minute a trace occurs of the object list. 

FireEventTracing Provide tracing about events that are sent from the server to its clients. 
MailboxEvtSinkTracing Provide tracing about mailbox events received. 
MessageEvtSinkTracing Provide tracing about message events received. 
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IMS Client Keys HKEY_CURRENT_USER\Software\Avaya\Integrated 
Messaging\Client 

EnableTracing This key must be enabled to allow tracing using the other keys below.  
ConstructorTracing This provides some tracing for when certain COM objects are 

constructed. As a whole it is not required for diagnostics. 
DestructorTracing This provides some tracing for when certain COM objects are destructed. 

As a whole it is not required for diagnostics. 
EnableFunctionTracing Generally used by the client software to trace out information about the 

functions that are being executed. 
EnableObjectTracing Allows certain created COM objects to be traced. 
EnableProxyTracing When a client connects to a server, it connects through a proxy. This 

settings allows information from the proxy to be traced. 
EnableRefTracing This indicates when the reference count for certain COM objects is 

changed (through AddRef, Release). 
EnableTagTracing When certain internal objects are created, such as a channel object for 

speech playback, this information is tracked. Using this setting every 
minute a trace occurs of the object list. 

MAPIEventTracing Allow tracing of MAPI events received from MAPI. 
MessageProcessingTracing Used for tracing what server commands the extension is using. 
UMSEventTracing Allow tracing of events received from the IMS server.  
TimeAndTrace Used for tracing how long certain MAPI events took to process. 
 

All the keys are based on the component as follows: 

• IMS (Voice) Server – “SOFTWARE\Avaya\Integrated Messaging\Voicemail” (e.g. 
“HKLM\SOFTWARE\Avaya\Integrated Messaging\Voicemail”) 

• IMS (Gateway) Server – “SOFTWARE\Avaya\Integrated Messaging\Gateway” 

• IMS Administration – “SOFTWARE\Avaya\Integrated Messaging\Admin” 

• IMS Client – “SOFTWARE\Avaya\Integrated Messaging\Client” (e.g. 
“HKCU\SOFTWARE\Avaya\Integrated Messaging\Client”). 

 

VM Server Specific 

• "CtiNotifyTracing" – Provide tracing to indicate that a Cti event has occurred. 

• "VmsNotifyTracing" – Provide tracing to indicate that a VMS API event has occurred. 
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IMS Installation Alternatives 
The IMS Server actually consists of two components in addition to the Voicemail Pro service, these are:  

• IMS Gateway Service. 
• IMS Voice Service. 

 

Typically both these services are installed on the same server as the Voicemail Pro Service and that is 
the installation process described in this documentation. However the IMS Gateway Service can be 
installed on the Exchange Server PC if required. Installation of the IMS Gateway Service onto the 
Exchange Server PC requires more installation steps. 

If the IMS Gateway Service is installed on the Exchange Server PC, IMS needs to access the Exchange 
server. Exchange must be started before IMS. More specifically, the MSExchangeIS and 
MSExchangeMTA services must be started before the IMS Gateway service. If the IMS and Exchange 
services are configured to start automatically on system boot, there may be a problem. When the system 
starts, Windows will launch both the IMS and Exchange services but not necessarily in the correct order. 
It is therefore necessary to force Windows to start the services in the correct order. 

This is accomplished by editing the registry as follows: 

1. Run regedt32.exe. This is normally located in \WINNT\SYSTEM32.  

2. From the Window menu, select the HKEY_LOCAL_MACHINE option.  

3. Navigate to the SYSTEM\CurrentControlSet\Services\IMS(Gateway) key.  

4. Open the DependOnService value. It should already contain the IMS (Restart) 

5. Append the MSExchangeIS and MSExchangeMTA strings.  

6. Note that the value is of type REG_MULTI_SZ, which means that each string should be 
separated by pressing the enter key.  

7. Close regedt32. Restart the machine and verify that IMS starts correctly.  

8. Note that it may take a few minutes after a restart for the Exchange and IMS services to be fully 
operational. 
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D. Known Issues 
Connection to IMS on a Domain Controller 
Scenario:  
Voicemail Pro with IMS will run on a PC running on a Domain Controller.  Note however that it is not 
recommended that IMS be installed on a Domain Controller. 

 

Problem:  
Voicemail Pro and IMS are running on a Domain Controller and IMS clients are having Problems 
connecting. 

 

Resolution:  
All Domain users who are using the IMS clients must be able to read and write the folder C:\Program 
Files\Avaya\IP Office\Voicemail Pro\VM\Accounts on the server.  

 



IMS Installation 

Integrated Messaging (IMS) Installation Page 52 
IP Office Issue 1a (14th May 2007) 

Problems Connecting to/Synchronizing with IMS 
If you are having problems connecting to the IMS server or having problems synchronizing: 

 

On the Client PC 
Make sure the mailbox name you entered is EXACTLY what is in the name section of the user form for 
their mailbox. This is the entry as it appears in the Username field of the IP Office User Profile Screen. 
This is case-sensitive. Verify that all the user names have been entered correctly and that you are not 
using illegal characters, only alpha/numeric characters and no punctuation. If this information is entered 
incorrectly, the IMS client will not connect to the IMS Server. 

Voicemail removes spaces at the end of mailbox names. If spaces are left at the end of a mailbox user's 
name in IP Office Manager, when the mailboxes are created, the space at the end of the name is 
dropped. When this occurs the mailbox cannot be found as there is a mismatch between the user name 
and directory. Verify that there are no spaces at the end of any of the user names in Manager. 

Make sure when you installed the client you gave the NAME of the VMPro/IMS server. Verify that you 
can ping the server by it's name. You may want to put an entry in the hosts and lmhosts with the #PRE 
option in the lmhosts.  

Remove the client, reboot and reinstall it and verify that these are put in correctly then change the 
dcomcnfg settings outlined above in Misc Troubleshooting and always run the AvayaFW.bat even if the 
Windows Firewall is turned off. 

 

On the Voicemail Pro/IMS Server machine 
Verify that you are using the proper domain account (IMS) to start the IMS services and VMPro service. 

 
 

On the Server, 
In dcomcnfg, verify that the Identity of the account that you are using to run the IMS Gateway, IMS 
Voice, and IMS Restart Services are the same Domain account you are using to start the Voicemail Pro 
and IMS services.  

  

Make sure the account has at least local admin rights on the PC or local and domain admin rights.  
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Check the event viewer and stop and start the VMPro and IMS services and see if you get any errors. 
You must have the logging level set to Most or All. 

Go into the control panel and run the IP Office Voicemail Pro Control Panel Applet and run through each 
tab and verify that all the information is correct and that you can browse for the server and email 
account. Run the check at the bottom of the applet and make sure it does not come back with an error, 
then check the event viewer and see if there are any errors. As long as you have the logging level set to 
most or all you should see errors in the event viewer application logs. 

Check to see if you setup the Outlook account correctly and make sure it can send and receive email. 
You should be logged in with the same domain account you are using to start the Voicemail Pro and IMS 
services (IMS). Verify that you can send and receive emails. 

Run the IMS admin tool and verify that the mailboxes have been setup properly. Un-assign then reassign 
them and verify that you can  browse and find the email and NT login accounts, do not just type them in 
to avoid typo's. If you are not receiving the emails and everything else is setup properly, you can enter 
the SMTP email address (User@domain.com) in the email section but verify that you have typed it 
correctly. Next run the “synchronize” on the account by right clicking and choosing synchronize. Next go 
into the event viewer and check for new errors.  

Reboot the VMPro/IMS server and make sure it boots up okay and starts all the services and there are 
no errors in the event viewer under application or system. 

Verify that the IMSClient executable has not been run on the VMPro/IMS. Go to add remove programs 
and verify that the IMS Client is not in the list. 

Ask yourself these questions: Are any client machines able to connect? If you have only installed the 
client on one machine make sure you try it on one or more other machines. Try different Makes and 
Models and operating systems if available to see if the problem is with a particular installation or build. If 
none of them can connect problem is most likely a problem on the server. If one or more can connect the 
problem is most likely on the client machine. 

 

IMPORTANT THINGS TO REMEMBER: 
Any time the user interacts with their voicemail/emails they must be connected to the IMS Gateway 
server on the voicemail PC. They can not work off line or the synchronization will be broken. 

• When installing IMS, Windows Messaging (MAPI) must be installed prior to the Voicemail Pro 
install.  

• This includes the connectivity to Microsoft Exchange Server. 

• The IMS (Voice) must be installed on the same machine as the Voicemail Server.  

• When entering the mailbox for the IMS client from the Integrated Messaging page within the 
options dialogue in Outlook, the mailbox must be the user’s name and not their extension 
number. 
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Unspecified Error 80004005 
When selecting the handset to playback the message, a dialog box similar to the message below may be 
received. 

 
This error is typically only seen when selecting the handset as the Output device. If the message is 
embedded or attached a user can play the message using desktop speakers. 

 

Cause  
This error message indicates that there may be a problem with permission configuration, thereby 
preventing the client from being able to establish a connection to the desktop extension. 

A common cause for this is misconfiguration of the extension number that the IMS Client must connect 
to. 

 

Solution  
To verify and if necessary correct the issue, open Outlook, Select Tools – Options –Integrated 
Messaging Tab. Insert the correct extension number into the field provided. 

Once completed play the message back from the client. This above symptom should now be resolved. 
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Outlook Cached Exchange Mode 
Avaya IP Office Integrated Messaging is not supported with Microsoft Outlook using Cached Exchange 
Mode (provided in Outlook 2003).  

Cached Exchange Mode can cause problems with Message Waiting light synchronization with IP Office 
terminals. 

 

To disable Cached Exchange Mode: 
1. Select Start | Settings | Control Panel | Mail. 
2. Select Email Accounts. 

3. Select View or change existing email Accounts. 

4. Select the Microsoft Exchange Server  
5. Select Change. 

6. Uncheck Use Cached Exchange Mode.  

7. Click OK.  

8. Close and restart Outlook be apply the change. 

 

Using Cached Mode 
IP Office IMS users who want to use Cached Mode when traveling outside of the Office can temporarily 
enable it operation.  

1. Turn on Cached Exchange Mode.  

2. Select the Integrated Messaging tab.  

3. Select Prompt before connecting to Voicemail Server . 
4. Click OK.  

5. Close Outlook.  

 

When the user logs in remotely and opens Outlook, they will be prompted by the message "Do you 
wish to connect to the Integrated Messaging server". They should select No before opening outlook. 
Outlook will not then try to synchronize voicemail messages in Outlook with Voicemail Pro. 

When the user is back in the office, they can then check Cached Exchange Mode, reopen Outlook and 
connect to the Voicemail Pro server for message synchronization. 
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Transferring an IMS Account to a New PC 
The voicemail call flows, greetings, IMS user accounts and other user settings can be transferred to a 
replacement Voicemail Pro server PC with the following steps: 

1. Export the Voicemail call flows 

2. Back up the Accounts, Names, Greetings Folders, and Custom wav files in a separate directory 

3. Navigate to C:\Program Files\Avaya\IP Office\Voicemail Pro, then run Backupreg.bat This will 
back up the IMS account information entered in the IMS Admin Tool to VMPRO.arf, NETALY.arf, 
IMSGATEWAY.arf. The files are backed up to C:\%WINDIR%\temp. (%WINDIR% is the directory 
where Windows is installed). 

4. Copy the three files to a backup device 

5. Install the Voicemail Pro software onto the new PC 

6. Stop the Voicemail Pro services and copy the Accounts, Names, Greetings Folders, and Custom 
wav files from the old PC to the directory on the new PC. 

7. Copy the VMPRO.arf, NETALY.arf, and IMSGATEWAY.arf files to the new PCs Window’s Temp 
directory (C:\windowstemp or C:\winnt\temp) 

8. Run Restorereg.bat file. This will restore the IMS user’s account information. 

9. Start the Voicemail Pro and IMS services. 

10. Import the VM Pro database. Save and make Live. 
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IMS Client Not Showing in Outlook Tools 
The Integrated Messaging Tab may be disabled and not show in Outlook’s Tool, Options tab. This is 
caused by outlook disabling the Extension.dll file, which can be caused by the IMS user opening 
Microsoft Outlook and not being able to synchronize with the Voicemail Pro server; if the user then 
closes and opens Outlook, they may receive the following error: 

 
If the user clicks Yes, Outlook will open and the Integrated Messaging client will not be able to 
synchronize Outlook with the client’s voicemail box - the user will be able to click on an IMS message 
and play the message, but the message waiting light will not turn off. 

 

To check to see if the extenstion.dll add-in is disabled: 
1. Open Outlook. Select Help | About Microsoft Office Outlook. 

2. Choose Disabled Items. 

3. Outlook will list all the programs that are disabled. 

 
4. Highlight Addin: c:\program files\avaya\ims client\extension.dll. 
5. Choose Enable. 

6. Click Close. 

7. Open and close Outlook and the Integrated Messaging tab will appear in Options | Tools. 
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Firewall Port Settings 
Windows users who install and use third party Firewall applications such as MacAfee Personal Firewall 
may experience problems using the Avaya IP Office Integrated Messaging Service with Outlook if ports 
that are blocked by the default installation of these products are not opened. 

Problems that may be experienced include: 

• Message waiting lights not turning off when messages are played. 

• Failure to connect to Integrated Messaging Service when Microsoft Outlook is opened. 

 

The following ports will need to be set to allow incoming and outgoing traffic: 

• UDP Port 67 

• UDP Port 69 

• TCP Port 135 

• TCP Port 2000 

• UDP Port 50791 

• UDP Port 50799 

 

VMPro Error 0x80004005 
When installing Voicemail Pro software, the following error message may be encountered: 

  

This error message occurs when clicking browse to add the email account for “Voicemail to Email” or 
“IMS” Applications, and is due to Voicemail Pro attempting to browse Outlook’s contacts folder for 
accounts when Outlook is not installed on the Voicemail Pro server. 

The account details can be added in manually by typing the full email address into the account details 
field and selecting apply. (Apply must be selected otherwise the settings will not be saved). 
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Windows Update Causes Voicemail Pro to Stop 
Voicemail Pro may stop working due to the lack of system resources when a MS Windows patch is 
downloaded and is waiting to be installed. As a result, Windows XP Professional and Windows 2003 
servers should either disable Windows Automatic Update or set it to only Notify. 

Windows Updates should be downloaded and installed after peak business hours on a regular basis. 
This will allow the installation to be done manually and testing of the update software to be done in a 
controlled fashion. 

This can be done by going to Start | Settings | Control Panel | System then selecting the Automatic 
Updates tab, and choosing either Notify Me or Turn Off. 
 

Saving IMS Messages Past Housekeeping 
Once read, a Voicemail message will be deleted after a period of time defined by the voicemail system 
administrator, the default being 30 days (720 hours). IP Office Integrated Messaging Pro clients can 
save a copy of the message locally by clicking the Floppy disk icon in the embedded Interface. 

  

When the floppy disk icon has a red cross superimposed, this indicated that the message is not saved. 
The message will be removed automatically by housekeeping. Click the icon to save the message. 

When the floppy disk icon has a green tick superimposed, the message is set as saved. 
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Outlook Delegates Cause IMS to Slow 
IP Office Integrated Messaging Pro (IMS) clients may appear to respond slowly or even lock up where 
the IMS client user has defined one or more delegates in Microsoft Outlook. 

These delegates should be included in IMS User settings in the IMS Administration tool. 

  

All delegates of an IMS Client’s Outlook should have their domain account and email address added into 
the permissions field, with “Access” permission selected. 

 

IMS Clients Not Connecting When Outlook Opened 
Avaya IP Office Voicemail Pro IMS Clients not connecting to Voicemail Pro when outlook is opened IMS 
Clients may experience problems when outlook is opened and the IMS software attempts to connect to 
the Voicemail Pro Server. 

The IMS Client will try to resolve the name of the Voicemail Pro server; this will fail if the Voicemail Pro 
computer name includes non alphanumeric characters. 

The Computer name of the Voicemail Pro server should not include non alphanumeric characters for this 
reason. 

Examples are “Voicemail_Pro” or “machine-001”. 

The preferred computer name would be “VoicemailPro” or “machine001”. 

In addition, DNS must be setup locally in the network and the clients should have their primary DNS 
requests pointed to that server. 
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Starting IP Office Services Using a Batch File 
In some instances, certain computers might not respond quickly enough in order to start all of the Avaya 
services in the correct order. In this circumstance, it can be advisable to create a batch file which will 
delay the start of these services until the PC is fully running. 

Avaya IP Office Services can be started successfully at system start-up using a scheduled task that 
initiates the batch file below. This batch file ensures that the services will start successfully and in the 
proper order. 

 

To set up the batch file: 
1. Set all Avaya services listed below to Manual start. Do not include Key Server. 

2. Create the batch file below and save it to %SYSTEMROOT%: 
@echo off 
rem Wait 60 seconds before execute. 
timeout /t 60 
net start CCC Delta Server 
net start CCC Reporting 
net start VMProDBService 
net start Voicemail Pro Service 
net start IMS(Restart) 
net start IMS(Voice) 
net start IMS(Gateway) 

3. Create a scheduled task to start the batch file at system start-up. 

 

Message Waiting Indicators Not Clearing 
All user names in a Small Community network using centralized Voicemail must have a completely 
unique entry in the User’s Name field. 

Examples of incorrect user names on the same system include: 

• User 1: STEVE SMITH 

• User 2: steve smith 

• User 3: Steve 

• User 4: Steve Smith 

• User 5: Steve-Smith 

 

User names must only use alphabetic characters. 

These examples may cause one mailbox to be created for the above users. This may prevent message 
waiting indicators from updating correctly, and Integrated Messaging (IMS) synchronization problems. 
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